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DRV2625 ERM, LRA Haptic Driver Evaluation Kit

The DRV2625 is a haptic driver designed for Linear Resonant Actuators (LRA) and Eccentric Rotating
Mass (ERM) motors. It provides many features which help eliminate the design complexities of haptic
motor control including reduced solution size, high efficiency output drive, closed-loop motor control, quick
device startup, memory for waveform storage, and auto-resonance frequency tracking.

The DRV2625EVM-CT Evaluation Module (EVM) is a complete demo and evaluation platform for the
DRV2625. The kit includes a microcontroller, linear actuator, eccentric rotating mass motor, and capacitive
touch buttons which can be used to completely demonstrate and evaluate the DRV2625.

This document contains instructions to setup and operate the DRV2625EVM-CT in demo and evaluation
mode.

Figure 1. DRV2625EVM-CT Board

Evaluation Kit Contents:
• DRV2625EVM-CT demo and evaluation board
• Micro-USB cable
• Demonstration Firmware

Required for programming and advanced configuration:
• Code Composer Studio™ (CCS) or IAR Embedded Workbench IDE for MSP430
• MSP430 LaunchPad (MSP-EXP430G2), or MSP430-FET430UIF hardware programming tool
• DRV2625EVM-CT firmware available on ti.com

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLOU432A
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1 Getting Started
The DRV2625 can be used as a demonstration or evaluation tool. When the DRV2625EVM-CT evaluation
module is powered on for the first time, a demo application automatically starts. To power the board,
connect the DRV2625EVM-CT to an available USB port on your computer using the included micro-USB
cable. The demo begins with a board power-up sequence and then enters the demo effects mode. The
four larger buttons on the wheel (1–4) can be used to sample haptic effects using both the ERM and LRA
motor in the top right corner.

Figure 2. Board Diagram

http://www.ti.com
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1.1 Evaluation Module Operating Parameters
The following table lists the operating conditions for the DRV2625 on the evaluation module.

Parameter Specification
Supply voltage range 2.7 V to 5.5 V
Power-supply current rating 400 mA

1.2 Quick Start Board Setup
The DRV2625EVM-CT firmware contains haptic waveforms which showcase the features and benefits of
the DRV2625. Follow the instructions below to begin the demo:
1. Out of the box, the jumpers are set to begin demo mode using USB power. The default jumper settings

are found in the table below.

Jumper Default Position Description
J3 Short pin 2-3 Powers using USB
J2 Short pin 2-3 USB power to DVDD
J5 Shorted Level translator
J17 Open Trigger/NRST for DRV2625
J7 Shorted Bypass the I-Sense
J8 Shorted Motor+ terminal
J9 Shorted Motor- terminal
J4 Open SDA/SCL connections to debug/Monitor advanced operations

2. Connect the included micro-USB cable to the USB connector on the DRV2625EVM-CT board.
3. Connect the other end of the USB cable to an available USB port on a computer, USB charger, or USB

battery pack.
4. If the board is powered correctly, the LEDs will blink and the LRA and the ERM actuator will spin and

stop at the start up.

http://www.ti.com
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2 DRV2625 Demonstration Program
The sections below provide a detailed description of the demo modes and effects.

2.1 Modes and Effects Table
The effects preloaded on the DRV2625EVM-CT are listed in Table 1. The modes are selected using the +
and – mode buttons in the center of the board. The current mode is identified by the white LEDs directly
above the mode buttons. Buttons B1–B4 trigger the effects listed in the description column and change
based on the selected mode.

Table 1. Mode and Effects Table

Mode Button Description Actuator Waveform
Location

Interface

Mode 0
LEDs Off

B1 Sharp Click ERM ROM Internal Trigger (I2C)
B2 Sharp Click LRA
B3 PulsingSharp ERM
B4 PulsingSharp LRA

Mode 1
LED M1 On

B1 Soft Bump ERM ROM Internal Trigger (I2C)
B2 Soft Bump LRA
B3 Double Click ERM
B4 Double Click LRA

Mode 2
LED M2 On

B1 Heartbeat x 3 ERM ROM Internal Trigger (I2C)
B2 Heartbeat x 3 LRA
B3 Buzz Alert 750 mS LRA
B4 Buzz Alert 750 mS ERM

Mode 3
LED M3 On

B1 Closed Loop RTP 7F Buzz LRA ROM RTP (I2C)
B2 Open Loop Pulsing with Auto Brake LRA RTP (I2C)
B3 Sine Wave Buzz RTP 7F LRA RTP (I2C)
B4 Open Loop Pulsing with no Auto

Brake
LRA RTP (I2C)

Mode 4
LED M1 On

B1 RTP Strength change on position of
the wheel

ERM and LRA ROM RTP (I2C)
B2
B3
B4
TI
Button

Toggle ERM/LRA Trigger One wire

http://www.ti.com
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Time (s)

V
o

lt
a

g
e

 (
2

V
/d

iv
)

0 20m 40m 60m 80m 100m

Acceleration

[OUT+] − [OUT−] (Filtered)

Time (s)

V
o

lt
a

g
e

 (
2

V
/d

iv
)

0 20m 40m 60m 80m 100m

Acceleration

[OUT+] − [OUT−] (Filtered)

Time (s)

V
o

lt
a

g
e

 (
2

V
/d

iv
)

0 20m 40m 60m 80m 100m

Acceleration

[OUT+] − [OUT−] (Filtered)

Time (s)

V
o

lt
a

g
e

 (
2

V
/d

iv
)

0 20m 40m 60m 80m 100m

Acceleration

[OUT+] − [OUT−] (Filtered)

DRV2625 Demonstration Program www.ti.com

6 SLOU432A–December 2015–Revised March 2017
Submit Documentation Feedback

Copyright © 2015–2017, Texas Instruments Incorporated

DRV2625 ERM, LRA Haptic Driver Evaluation Kit

2.2 Description of the Demo Modes
The following section highlights different features and benefits of using the DRV2625.

2.2.1 Mode Off – Haptics Effect Sequences
Below are a set of ERM and LRA Sharp Click waveforms. The four effects below show the difference
between closed and open loop operation for both ERM and LRA.

In closed-loop operation for ERM’s, the driver automatically overdrives and brakes the actuator. In open-
loop, the waveform must be predefined with overdrive and braking.

For LRA’s in closed-loop, the driver automatically tracks the resonant frequency, and overdrives and
brakes the actuator. In open-loop, the waveform must be predefined with a static drive frequency, and
overdrive and braking times.

Figure 3. LRA Sharp Click Closed Loop Waveform Figure 4. LRA Sharp Click Open Loop Waveform

Figure 5. ERM Sharp Click Closed Loop Waveform Figure 6. ERM Sharp Click Open Loop Waveform

2.2.2 Automatic Braking in Open Loop
The DRV2625 offers automatic braking in open-loop operation for both ERM and LRA. See Figure 7 and
Figure 8 below for two separate LRA waveforms that show the advantage of using closed-loop breaking
out of open loop operation. Notice that the settling time of the waveform with automatic braking is 15 ms,
significantly faster than the 40-ms time achieved without automatic braking enabled.

http://www.ti.com
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Figure 7. LRA Closed-Loop Click Waveform Figure 8. LRA Open-Loop Click Waveform

2.2.3 Auto-Resonance Tracking
Figure 9 and Figure 10 below showcase the advantages of the Smart Loop Architecture which includes
auto-resonance tracking, automatic overdrive, and automatic braking. The two images below show the
difference in acceleration between LRA auto-resonance ON and LRA auto-resonance OFF. Notice that the
acceleration is higher when driven at the resonant frequency. The auto-resonance ON waveform has 1.32
G of acceleration and the auto-resonance OFF waveform has 0.92 G of acceleration. The auto-resonance
ON waveform has 43% more acceleration.

Figure 9. LRA Auto-Resonance ON Waveform (Button 1) Figure 10. LRA Auto-Resonance OFF Waveform (Button 2)

The reason for higher acceleration can be seen in the acceleration versus frequency graph below. The
LRA has a very narrow operating frequency range due to the properties of a spring-mass system.
Furthermore, the resonance frequency drifts over various conditions such as temperature and drive
voltage. With the Smart Loop auto-resonance feature, the DRV2625 dynamically tracks the exact resonant
frequency to maximize the vibration force.

http://www.ti.com
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Figure 11. Acceleration Versus Frequency

3 Additional Hardware Modes
Additional modes are available on the DRV2625EVM-CT providing increased board control and
functionality.

3.1 Accessing GUI Mode
The DRV2625EVM-CT has the ability to be controlled via Haptics Control Console. In order to place the
EVM into ‘GUI Mode’, hold down the (+) for approximately 3 seconds. The LED indicators will blink, and
the right half of the LED’s will remain on, indicating that the EVM is in GUI Mode.

3.2 Accessing Bluetooth Mode
The DRV2625EVM-CT Evaluation Module also features a mobile app for control over Bluetooth from an
iOS app. In order to control the evaluation module via the mobile app, hold down the (-) for approximately
3 seconds. The LED indicators will blink, and the left half of the LED’s will remain on, indicating that the
EVM is in ‘Bluetooth Mode’.

3.3 Haptics Control Console GUI
Haptics Control Console (HCC) allows the user to have control over the DRV2625 driver through a
number of controls and features.

To control the DRV2625EVM-CT via HCC, connect the EVM to an available port on a computer using the
included micro USB cable. Once the EVM is powered on, access GUI Mode by holding down the (+) for
approximately 3 seconds as described in Section 3.1.

Open up the latest version of Haptics Control Console, and on the tool bar the USB tab will read out
'2.Haptics DRV2625 EVM [version]'. Once the GUI has recognized the DRV2625EVM-CT, press 'Connect'
to access the device Console.

Once connected the HCC provides the user flexibility to control the EVM functions through a GUI
‘Console’, and the ability to read and write to and from the DRV2625 through the ‘Register Map’ window
as seen below inFigure 12 below.

http://www.ti.com
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Figure 12. Haptics Control Console

3.3.1 DRV2625 Console
The DRV2625 Console is divided into three sections Initialization, Work Mode, and Board Status, as seen
below in Figure 13. Each section allows the user to control the device on the EVM through I2C writes and
communication.

Figure 13. HCC DRV2625 Console

Please refer to the Haptics Control Console Users Guide for more detailed information on the device
management features accessible through Haptics Control Console. The user’s guide can be found on
www.ti.com.

4 Hardware Configuration
The DRV2625EVM-CT is very flexible and can be used to completely evaluate the DRV2625. The
following sections list the various hardware configurations.

4.1 Input and Output Overview
The DRV2625EVM-CT allows complete evaluation of the DRV2625 though test points, jacks, and
connectors. Table 2 gives a brief description of the hardware.

http://www.ti.com
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Table 2. Hardware Overview

Signal Description I/O
DRV TRIG External input or monitor for DRV2625 IN/TRIG pin Input/Output
NRST External DRV2625 Shutdown control Input

OUT+/OUT– Filtered output test points for observation, connect to oscilloscope or
measurement equipment Output

USB USB power (5 V) Input
VBAT External Supply Power (2.5 V – 5.5 V) Input
SBW MSP430 programming header Input/Output
I2C DRV2625 and MSP430 I2C bus Input/Output

Hardware configuration details can be found in the following sections.

4.2 Power Supply Selection
The DRV2625EVM-CT can be powered by USB and an external power supply (VBAT). Jumpers J3 is
used to select USB or VBAT for the DRV2625 and MSP430G2553, respectively. See Table 3 for possible
configurations.

(1) The DRV2625 supply must be on before operating the MSP430.

Table 3. Power Supply Configurations

Supply Configuration DRV MSP DRV2625 Supply Voltage (1)

USB – Both USB USB 5 V
DRV2625 external supply, MSP430
USB VBAT USB VBAT

4.3 Using an External Actuator
The DRV2625EVM-CT can be used with an external actuator. Follow the instructions below to attach an
actuator to the OUT terminal block.
1. Remove jumpers J8 and J9 which disconnects the on-board actuators from the DRV2625.
2. Attach the positive and negative leads of the actuator to the green OUT terminal block keeping in mind

polarity.
3. Screw down the terminal block to secure the actuator leads.

Use the green terminal block when connecting an external actuator. The OUT+ and OUT– test points
have low-pass filters and should only be used for oscilloscope and bench measurements.

5 Measurement and Analysis
The DRV2625 uses PWM modulation to create the output signal for both ERM and LRA actuators. To
measure and observe the DRV2625 output waveform, connect an oscilloscope or other measurement
equipment to the filtered output test points, OUT+ and OUT–.

Figure 14. Terminal Block and Test Points

http://www.ti.com
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The DRV2625 drives LRA and ERM actuators using a 20-kHz PWM modulated waveform, but only the
frequencies around the LRA resonant frequency or the ERM DC drive voltage are relevant to the haptic
actuator vibration. The higher frequency switching content does not contribute to the vibration strength of
the actuator and can make it difficult to interpret the modulated output waveform on an oscilloscope. The
oscilloscope image on the left shows the DRV2625 unfiltered waveform and the image on the right shows
a filtered version used for observation and measurement.

Figure 15. DRV2625 Unfiltered Waveform Figure 16. DRV2625 Filtered Waveform

6 Modifying or Reprogramming the Firmware
The MSP430 firmware on the DRV2625EVM-CT can be modified or reprogrammed to create new haptic
effects or behaviors. Find the latest firmware source code and binaries on ti.com. Follow the instructions
below to modify or reprogram the DRV2625EVM-CT.
1. Purchase one of the following MSP430F5510 compatible programmers:

• MSP430 64-pin Target Development Board and MSP-FET(MSP-FETU64USB)
• MSP-FET MCU Programmer and Debugger

2. Download and install Code Compose Studio (CCS) or IAR Embedded Workbench IDE.
3. Download the DRV2625EVM-CT source code and binaries from ti.com.
4. Connect the programmer to an available USB port.
5. Connect the programmer to the J6 header on the DRV2625EVM-CT.
6. In CCS,

(a) Open the project file by selecting Project→Import Existing CCS Project.
(b) Select Browse and navigate to the DRV2625EVM-CT project folder, then press OK.
(c) Select the checkbox next to the DRV2625EVM-CT project in the Discovered projects window and

then press Finish.
(d) Before compiling, navigate to Project→Properties→Build→MSP430 Compiler→Advanced

Options→Language Options and make sure the checkbox for Enable support for GCC extensions
(–gcc) is checked.

7. In IAR,
(a) Create a new MSP430 project in IAR,
(b) Select the MSP430F5510 device,
(c) Copy the files in the project folder downloaded from ti.com to the new project directory.

Figure 17 below shows the connection between the MSP430 Programmer and Debugger (MSP-FET) and
the DRV2625EVM-CT.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLOU432A
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Figure 17. FET Programmer Connection

http://www.ti.com
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7 Schematic

Figure 18. DRV2625EVM-CT Schematic Page 1

http://www.ti.com
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Figure 19. DRV2625EVM-CT Schematic Page 2
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8 Layout

Figure 20. Top Layer
Figure 21. Layout Layer 2
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Figure 22. Layout Layer 3 Figure 23. Layout Layer 4

http://www.ti.com
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9 Bill of Materials

Item # Designator Quantity Value Part Number Manufacturer Description Package Reference

1 !PCB1 1 AIP044 Any Printed Circuit Board

2 ANT1, ANT4, L2, L3 4 2.4nH LQG15HS2N4S02D MuRata Inductor, Multilayer, Air Core, 2.4 nH, 0.3 A, 0.15 ohm, SMD 0402 polarized

3 ANT3, C15, C18 3 1pF GRM1555C1H1R0CA01D MuRata CAP, CERM, 1 pF, 50 V, +/- 5%, C0G/NP0, 0402 0402

4 ANT5, R3, R4, R6, R7, R9,
R39, R40, R46, R47, R48

11 0 CRCW04020000Z0ED Vishay-Dale RES, 0, 5%, 0.063 W, 0402 0402

5 ANT6 1 0.5pF GRM1555C1HR50BA01D MuRata CAP, CERM, 0.5 pF, 50 V, +/- 20%, C0G, 0402 0402

6 BSL1, MSPRST1 2 TL1015AF160QG E-Switch Switch, Tactile, SPST-NO, 0.05A, 12V, SMT Switch, 4.4x2x2.9 mm

7 C1, C2 2 470pF C1005C0G1H471J TDK CAP, CERM, 470 pF, 50 V, +/- 5%, C0G/NP0, 0402 0402

8 C3, C4, C19, C38, C39, C40,
C41, C42, C43, C44, C45

11 0.1uF GRM155R71C104KA88D MuRata CAP, CERM, 0.1 µF, 16 V, +/- 10%, X7R, 0402 0402

9 C5 1 0.27uF GRM155R61A274KE15D MuRata CAP, CERM, 0.27 µF, 10 V, +/- 10%, X5R, 0402 0402

10 C6, C7, C8, C28, C29 5 0.1uF GRM155R61C104KA88D MuRata CAP, CERM, 0.1uF, 16V, +/-10%, X5R, 0402 0402

11 C9, C30 2 10uF GRM155R61A106ME44 MuRata CAP, CERM, 10 µF, 10 V, +/- 20%, X5R, 0402 0402

12 C10, C33, C36 3 1uF GRM155R61A105KE15D MuRata CAP, CERM, 1 µF, 10 V, +/- 10%, X5R, 0402, CAP, CERM,
1uF, 10V, +/-10%, X5R, 0402, CAP, CERM, 1 µF, 10 V, +/-
10%, X5R, 0402

0402

13 C11, C12, C13, C14, C22,
C23

6 12pF GRM1555C1H120JA01D MuRata CAP, CERM, 12 pF, 50 V, +/- 5%, C0G/NP0, 0402, CAP,
CERM, 12 pF, 50 V, +/- 5%, C0G/NP0, 0402, CAP, CERM, 12
pF, 50 V, +/- 5%, C0G/NP0, 0402, CAP, CERM, 12 pF, 50 V,
+/- 5%, C0G/NP0, 0402, CAP, CERM, 12pF, 50V, +/-5%,
C0G/NP0, 0402, CAP, CERM, 12pF, 50V, +/-5%, C0G/NP0,
0402

0402

14 C16, C17 2 15pF GRM1555C1H150JA01D MuRata CAP, CERM, 15 pF, 50 V, +/- 5%, C0G/NP0, 0402 0402

15 C20, C21 2 18pF GRM1555C1H180JA01D MuRata CAP, CERM, 18pF, 50V, +/-5%, C0G/NP0, 0402 0402

16 C24, C25 2 10pF GRM1555C1H100JA01D MuRata CAP, CERM, 10pF, 50V, +/-5%, C0G/NP0, 0402 0402

17 C26, C32 2 0.22uF GRM155R71C224KA12D MuRata CAP, CERM, 0.22uF, 16V, +/-10%, X7R, 0402 0402

18 C27 1 0.47uF GRM155R61C474KE01 MuRata CAP, CERM, 0.47uF, 16V, +/-10%, X5R, 0402 0402

19 C31 1 4.7uF GRM155R61A475M MuRata CAP, CERM, 4.7uF, 10V, +/-20%, X5R, 0402 0402

20 C34, C35 2 22uF GRM21BR61C226ME44 MuRata CAP, CERM, 22 µF, 16 V, +/- 20%, X5R, 0805 0805

21 C37 1 47pF GRM1555C1E470JA01D MuRata CAP, CERM, 47pF, 25V, +/-5%, C0G/NP0, 0402 0402

22 C46 1 10uF GRM155R61A106ME21D MuRata CAP, CERM, 10 µF, 10 V, +/- 20%, X5R, 0402 0402

23 D1, D13, D18 3 Green LTST-C190GKT Lite-On LED, Green, SMD 1.6x0.8x0.8mm

24 D2, D3, D4, D5, D6, D7, D8,
D9, D10, D11, D12

11 SML312WBCW1 Rohm LED, White, SMD LED, 0603

25 D14 1 5.6V MMSZ5232B-7-F Diodes Inc. Diode, Zener, 5.6V, 500 mW, SOD-123 SOD-123

26 D15 1 Green 150060VS75000 Wurth Elektronik eiSos LED, Green, SMD LED_0603

27 D16 1 Blue LB Q39G-L2N2-35-1 OSRAM LED, Blue, SMD BLUE 0603 LED

28 D17 1 Yellow/gree
n

SML-P12MTT86 Rohm LED, Yellow/green, SMD 0402 LED

29 H1 1 ELV1036A AAC AAC1036 LRA Actuator Used in PnP output

30 H2 1 TI-EVACASE-BLACK Royal Case TI Black EVA Case Used in PnP output

31 H3 1 3-5-468MP 3M TAPE TRANSFER ADHESIVE 3" X 5YD Used in PnP output

32 H4 1 2-5-4466W 3M TAPE POLY FOAM 2" x 5YD Used in PnP output
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Item # Designator Quantity Value Part Number Manufacturer Description Package Reference

33 H5 1 Heavy Metal Metal Block (Custom Block, Heavy Metal, See metal block
spec)

Used in PnP output

34 J1, J10 2 1725656 Phoenix Contact Terminal Block, 100mil, 2x1, 6A, 63V, TH 6.2x8.5x5.54 mm

35 J2, J3, J4 3 5-146278-3 TE Connectivity Header, 100mil, 3x1, Tin, TH Header, 3x1, 100mil, TH

36 J5 1 90120-0122 Molex Header, 100mil, 2x1, Tin, TH Header 2x1

37 J6 1 LPPB061NGCN-RC Sullins Connector Solutions Receptacle, 50mil, 6x1, Gold, R/A, TH 6x1 Receptacle

38 J7, J8, J9, J17 4 5-146278-2 TE Connectivity Header, 100mil, 2x1, Tin, TH Header, 2x1, 100mil, TH

39 J11 1 GRPB052VWVN-RC Sullins Connector Solutions Header, 50mil, 5x2, Gold, TH Header, 5x2, 50mil

40 J16 1 DX4R205JJAR1800 JAE Electronics Connector, Receptacle, Micro-USB Type AB, R/A, Bottom
Mount SMT

Connector, USB Micro AB

41 L1 1 10uH CKS2125100M-T Taiyo Yuden Inductor, Multilayer, Ferrite, 10 µH, 0.11 A, 0.52 ohm, SMD 0805

42 L4 1 1500 ohm BLM18HE152SN1D MuRata Ferrite Bead, 1500 ohm @ 100 MHz, 0.5 A, 0603_950 0603_950

43 M1 1 BAL-3611 NIDEC SEIMITSU Motor, SMT 15.1x4.55mm

44 R1, R2, R13, R14, R15, R16,
R17, R18, R19

9 100k CRCW0402100KJNED Vishay-Dale RES, 100 k, 5%, 0.063 W, 0402, RES, 100 k, 5%, 0.063 W,
0402, RES, 100k ohm, 5%, 0.063W, 0402, RES, 100k ohm,
5%, 0.063W, 0402, RES, 100k ohm, 5%, 0.063W, 0402, RES,
100k ohm, 5%, 0.063W, 0402, RES, 100k ohm, 5%, 0.063W,
0402, RES, 100k ohm, 5%, 0.063W, 0402, RES, 100k ohm,
5%, 0.063W, 0402

0402

45 R5 1 0.18 ERJ-3RSFR18V Panasonic RES, 0.18, 1%, 0.1 W, 0603 0603

46 R10, R38, R45, R49 4 1.5k CRCW04021K50JNED Vishay-Dale RES, 1.5k ohm, 5%, 0.063W, 0402 0402

48 R23 1 1.40k CRCW04021K40FKED Vishay-Dale RES, 1.40k ohm, 1%, 0.063W, 0402 0402

49 R24 1 100 CRCW0402100RJNED Vishay-Dale RES, 100 ohm, 5%, 0.063W, 0402 0402

50 R25 1 1.0Meg CRCW04021M00JNED Vishay-Dale RES, 1.0Meg ohm, 5%, 0.063W, 0402 0402

51 R26, R27, R28, R29, R30,
R31, R32, R33, R34, R35,
R36

11 75.0 CRCW040275R0FKED Vishay-Dale RES, 75.0 ohm, 1%, 0.063W, 0402 0402

52 R37 1 33k CRCW040233K0JNED Vishay-Dale RES, 33k ohm, 5%, 0.063W, 0402 0402

53 R41 1 100k RG1005P-104-B-T5 Susumu Co Ltd RES, 100 k, 0.1%, 0.063 W, 0402 0402

54 R42 1 150 CRCW0402150RJNED Vishay-Dale RES, 150, 5%, 0.063 W, 0402 0402

55 R43 1 249 CRCW0402249RFKED Vishay-Dale RES, 249 ohm, 1%, 0.063W, 0402 0402

56 R44 1 270 CRCW0402270RJNED Vishay-Dale RES, 270, 5%, 0.063 W, 0402 0402

57 S1 1 PTS840 PM SMTR LFS C&K Components SWITCH TACTILE SPST-NO 0.05A 12V, SMT 3.5x1.35x3.55mm

58 SH-J1, SH-J2, SH-J3, SH-J4,
SH-J5, SH-J6

6 1x2 969102-0000-DA 3M Shunt, 100mil, Gold plated, Black Shunt

59 TP1, TP8 2 Orange 5013 Keystone Test Point, Multipurpose, Orange, TH Orange Multipurpose
Testpoint

60 TP2, TP3 2 Black 5011 Keystone Test Point, Multipurpose, Black, TH Black Multipurpose
Testpoint

61 U1 1 DRV2625YFF Texas Instruments DRV2625YFF, YFF0009AHAN YFF0009AHAN

62 U2 1 NA231AIYFF Texas Instruments High- or Low-Side Measurement, Bidirectional
CURRENT/POWER MONITOR with 1.8-V I2C Interface,
YFF0012AKAD

YFF0012AKAD

63 U3 1 CC2640F128RGZR Texas Instruments Ultra low-power ARM Cortex M3 2.4 GHz Radio MCU,
Bluetooth Low Energy, RGZ0048A

RGZ0048A

64 U4 1 24AA32AT-I/OT Microchip 32K I2C™ Serial EEPROM, SOT-23-5 SOT-23-5
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Item # Designator Quantity Value Part Number Manufacturer Description Package Reference

65 U5 1 TS5A12301EYFP Texas Instruments IEC LEVEL 4 ESD-PROTECTED 0.75-O SPDT ANALOG
SWITCH WITH 1.8-V COMPATIBLE INPUT LOGIC,
YFP0006AAAA

YFP0006AAAA

66 U6 1 TXS0102DCT Texas Instruments 2-BIT BIDIRECTIONAL VOLTAGE-LEVEL TRANSLATOR FOR
OPEN-DRAIN AND PUSH-PULL APPLICATIONS, DCT0008A

DCT0008A

67 U7 1 MSP430F5510IZQEA Texas Instruments 25 MHz Mixed Signal Microcontroller with 32 KB Flash, 4096 B
SRAM and 47 GPIOs, -40 to 85 degC, 80-pin BGA (ZQE),
Green (RoHS & no Sb/Br)

ZQE0080A

68 U8 1 TPS73633DBV Texas Instruments Cap-Free, NMOS, 400mA Low-Dropout Regulator with Reverse
Current Protection, DBV0005A

DBV0005A

69 U9 1 TPD2E001IDRLRQ1 Texas Instruments Automotive Catalog Low-Capacitance + / - 15 kV ESD-
Protection Array for High-Speed Data Inter, 2 Channels, -40 to
+85 degC, 5-pin SOT (DRL), Green (RoHS & no Sb/Br)

DRL0005A

70 Y1 1 FC-135 32.7680KA-A3 Epson Crystal, 32.768 KHz, 12.5 pF, SMD SMD, 2-Leads, Body
3.2x1.5mm

71 Y2 1 TSX-3225 24.0000MF20G-
AC3

Epson Crystal, 24 MHz, 9 pF, SMD SMD, 4-Leads, Body
2.65x3.35mm, Height
0.6mm

72 Y3 1 ABM8-24.000MHZ-B2-T Abracon Corportation Crystal, 24.000MHz, 18pF, SMD 3.2x0.8x2.5mm

73 Y4 1 FC-12M 32.7680KD-A3 Epson Crystal, 32.768kHz, 12.5pF, SMD Crystal 2.05x.6x1.2mm

74 FID1, FID2, FID3 0 N/A N/A Fiducial mark. There is nothing to buy or mount. Fiducial

75 J12, J13 0 PEC06SAAN Sullins Connector Solutions Header, 100mil, 6x1, Tin, TH TH, 6-Leads, Body
608x100mil, Pitch 100mil

76 R8 0 0 CRCW04020000Z0ED Vishay-Dale RES, 0, 5%, 0.063 W, 0402 0402

77 R11, R12 0 2.2k CRCW04022K20JNED Vishay-Dale RES, 2.2k ohm, 5%, 0.063W, 0402 0402
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Revision History

Revision History
NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

Changes from Original (December 2016) to A Revision ................................................................................................ Page

• Changed 'LRM' to 'LRA' in Actuator column of Mode 2 – B3 row in Table 1...................................................... 5
• Changed 'ERA' to 'ERM' in Actuator column of Mode 2 – B4 in Table 1 .......................................................... 5
• Deleted 'ROM Library Mode' and 'Waveform Library Effects List' sections ....................................................... 8

1 Trademarks
Code Composer Studio is a trademark of Texas Instruments.
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